This version of the software has been retired.
NOTICE

This document and the Sage 300 Construction and Real Estate MyAssistant software may be used only in accordance with the accompanying Innovative Software Design End User License Agreement. You may not use, copy, modify, or transfer the Sage 300 Construction and Real Estate MyAssistant software or this documentation except as expressly provided in the license agreement.

© 2016 Innovative Software Design. All rights reserved.
# Table of Contents

Conventions Used in this Document ................................................................. 3
Before You Install ............................................................................................... 5
  Hardware and Software Compatibility ............................................................ 7
  Minimum Hardware Requirements ................................................................... 7
  Supported Software ......................................................................................... 7
  Email Server Compatibility ............................................................................ 7

Support and Training .......................................................................................... 8
  Telephone Support .......................................................................................... 8
  Sage Customer Portal ..................................................................................... 8
  Training ........................................................................................................... 8
    Sage University ............................................................................................ 8
    MyAssistant YouTube Channel ..................................................................... 8
    Local Business Partner ................................................................................ 8

Chapter 1 – Installing MyAssistant Server ......................................................... 9
  Step 1 – MyAssistant Server Installation .......................................................... 10
  Step 2 – MyAssistant License Agreement ........................................................ 11
  Step 3 – Prerequisites for MyAssistant Server .................................................. 12
  Step 4 – MyAssistant Software ....................................................................... 13
  Step 5 – You Have Completed Installing the MyAssistant Server ..................... 14
  Start the MyAssistant Configuration Manager ............................................... 15

Chapter 2 – MyAssistant Server Configuration ................................................. 16
  Read this section carefully ............................................................................. 16
    MyAssistant Server Configuration steps: ................................................. 16
      Considerations before you begin: ............................................................... 16
  Step 1 – Welcome ......................................................................................... 17
  Step 2 – Product Activation .......................................................................... 18
  Step 3 – Database Connection ....................................................................... 19
  Step 4 – Create the MyAssistant Database .................................................... 20
  Step 5 – Sage 300 CRE Data Folders .............................................................. 21
  Import Sage Database Customizations ............................................................ 22
  Step 6 – Notification E-Mail Account .............................................................. 23
    Determining Mail Settings in Outlook for Microsoft Office 365 and Outlook 2016 ........................................................................ 24
    Determining Mail Settings in Outlook 2013 ................................................ 25
    Determining Mail Settings in Outlook 2010 ................................................ 26
  Step 7 – Server Options ................................................................................ 27
Chapter 3 – Installing MyAssistant Workstation

Step 1 – Welcome
Step 2 – MyAssistant License Agreement
Step 3 – Prerequisites for MyAssistant Workstation
Step 4 – Install the Software
Step 5 – You Have Completed Installing MyAssistant

Chapter 4 – MyAssistant Workstation Configuration

Step 1 – Welcome Screen
Step 2 – Product Activation
Step 3 – Entering Sage 300 CRE Data Folder Information
Step 4 – User Profile

Chapter 5 – Additional Settings

Antivirus Exceptions
MyAssistant Drive Mapper Tool

Chapter 6 – Installing on a Terminal Server

What is Involved
Before Installing
Installing the MyAssistant Server
Activating the MyAssistant Workstation

Conclusion
Conventions Used in this Document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in bold type.
- Information you enter into the software is in bold type, as in the following example: Enter Miscellaneous in the Amount Type box.
- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
- The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

TIP: Helpful information to make your experience better.

NOTE: This symbol draws your attention to information of particular interest such as information not included in steps.

CAUTION: This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.
MyAssistant Installation Guide

This document steps through the installation and configuration of Sage 300 CRE MyAssistant 16.1. This process consists of the following steps:

1. Installing the MyAssistant Server software on your Sage 300 CRE Server.
2. Configuring the MyAssistant Server by completing the MyAssistant Configuration Wizard.
3. (Optional): Installing the MyAssistant Drive Mapper tool. Refer to Chapter 5 to determine if you need to install this tool.
4. Installing MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant will be used.
5. Activating and configuring the MyAssistant software for each Windows user that will use MyAssistant.

Installing and configuring the MyAssistant server should take approximately 40 minutes. Installing each MyAssistant workstation should take approximately 10 minutes.

⚠️ CAUTION: If you are upgrading from a previous version of MyAssistant, please refer to the MyAssistant Upgrade Guide for upgrade instructions. Please contact Sage Support if you need a copy of the Sage 300 MyAssistant Upgrade Guide.
Before You Install

1. Identify the computer where the MyAssistant Server will be installed. Installing the MyAssistant Server on your Sage 300 CRE server is recommended. If this is not an option, the MyAssistant Server can be installed on another server operating system with a compatible version of Sage 300 CRE installed.

2. The computer where the MyAssistant Server is installed must meet the minimum Sage 300 CRE MyAssistant Hardware & Software requirements and must be left on 24/7.

3. Identify a Sage 300 CRE User and password that will be used to access Sage 300 CRE data from MyAssistant. This Operator should have sufficient security privileges to access the Sage 300 CRE data that you would like MyAssistant to monitor.

   **IMPORTANT:** Confirm that the password for this Sage 300 CRE User is set to never expire.

4. Select the Email account/address that MyAssistant will use to send Notification email messages. You will need the name or IP address for the outgoing mail server, as well as the username and password used to log into the email account. See Chapter 2, Step 6 for instructions.

5. Identify the computers (desktops or Citrix/Terminal servers) where the MyAssistant Workstation(s) will be installed. MyAssistant Workstations need to be installed for all users who will set up MyAssistant Tasks, view Notifications from the MyAssistant Live Tile, run MyAssistant Tasks and/or work with their Notifications in the Sage Desktop.

6. If your network is monitored by a proxy server, you will need to provide a proxy server user and password to activate MyAssistant.

   **NOTE:** MyAssistant will need to be activated for each Windows user that will use the software. This applies to the use of MyAssistant on standalone workstations and Citrix or Terminal servers. The **MyAssistant Product Key** determines the features available to each user:

   - The **MyAssistant Server product key** is to activate the MyAssistant Server.
   - The **MyAssistant Designer product key** provides access to setup features such as creating and scheduling MyAssistant Tasks and defining security. This key provides all of the functionality of the MyAssistant application.
   - The **MyAssistant product key** allows users to run Tasks and send emails via the MyAssistant application, as well as view and work with Notifications using the Sage Desktop and MyAssistant Live Tile.

7. Verify you can start the Sage 300 CRE software on each computer, including the server where the MyAssistant Server will be installed.

8. If you are using the Sage 300 CRE Service Management application, open Service Management and run a report to ensure that an ODBC connection to the SM database has been established.

9. Ensure the latest Microsoft Windows and Microsoft Office updates have been installed, including on the server. We recommend installing all High Priority updates at a minimum.
10. Confirm that Windows User Access Control (UAC) is turned off on ALL machines where MyAssistant will be installed. User Account Control settings can be found by going to Control Panel > User Accounts > User Accounts > Change User Account Control settings.

- If the MyAssistant Server is going to be installed on a Windows 2008 R2 server or later, UAC will need to be deactivated in the registry at the following path:
  - HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
- Double click on “EnableLUA” and change the value to “0”, then click “OK”
- UAC needs to remain off on any machine where the MyAssistant Server is installed. This includes when the MyAssistant Server is installed on the Terminal/Citrix server.

**IMPORTANT:** Turn off any antivirus and firewall software on server where the MyAssistant server will be installed. That software can be turned on again after the MyAssistant Server installation and configuration have both completed, but exceptions will need to be added (see Chapter 5 for more details).

11. Sage 300 CRE MyAssistant installs the following software:

- Microsoft SQL Server 2012 Express (On the Server Only)
- Sage 300 CRE MyAssistant software

Removing any of the above will disable the Sage 300 CRE MyAssistant software.

**IMPORTANT:** Confirm that the Windows users installing and configuring have access to the following locations:

- **On the MyAssistant Server:** Access to Program Files, Program Data, and can write to the Local Machine hive of the Windows Registry.
- **On a MyAssistant Workstation:** Access to Program Files, Program Data, and can write to the Current User hive of the Windows Registry.
Hardware and Software Compatibility

Minimum Hardware Requirements
The following are the minimum hardware requirements for Sage 300 CRE MyAssistant.

MyAssistant Workstation Installation
- 2 GB of available memory
- 1 GB of available disk space
- Video card capable of 1024 x 768 resolution

MyAssistant Server Installation
- 4 GB of available memory
- 5 GB of available disk space
- Video card capable of 1024 x 768 resolution

Supported Software
Sage 300 CRE MyAssistant 16.1 must be installed on a computer running one of the following operating systems:

- Windows 7 (32 or 64 bit)
- Windows Server 2008 R2 (32 or 64 bit)
- Windows Server 2012
- Windows Server 2012 R2
- Windows Server 2016
- Windows 8.1 (32 or 64 bit)
- Windows 10 (32 or 64 bit)

If possible, install the MyAssistant Server software on your Sage 300 CRE server. If this is not possible, the MyAssistant server software can be installed on another machine running one of the Windows Server operating systems listed above.

MyAssistant must be installed on a computer with a constant connection to the Internet for access to the MyAssistant Activation server.

MyAssistant version 16.1 is compatible with Sage 300 Construction and Real Estate v16.1.

Sage 300 CRE Security must be enabled to send Sage 300 CRE Report Designer reports listed on a Report menu in a supported Sage 300 CRE application. This includes reports designed with either the Sage 300 CRE Report Designer or Crystal Reports applications.

Email Server Compatibility
MyAssistant is compatible with most SMTP compatible email servers. MyAssistant has been tested with Microsoft Exchange and Gmail.
Support and Training

Telephone Support
When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following exceptions:

- Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)
- Standard United States holidays
- Quarterly company meetings

Sage Customer Portal
You may log on to the Sage Customer Portal at: https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:

- Knowledgebase: Find answers to your questions, access downloads, and subscribe to your favorite articles. This service is available online 24/7.
- Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as telephone support.
- Online Support Request: If you have a question or an issue that is not urgent, you can submit an online support ticket. A customer support analyst will contact you during regular telephone support hours.

Training
Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available and upcoming classes.

How to access MyAssistant training options in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. In the page that opens, click [Product Training] on the left side of the screen.
4. Click [MyAssistant] in the list that opened.
5. Select either [Realtime Learning] or [Replay Learning] and review the available options in each.

How to access Complimentary MyAssistant Training in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining into a web browser.
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.
Chapter 1 – Installing MyAssistant Server

Perform the following to initiate the MyAssistant Server installation:

1. Log on to your future MyAssistant Server with a Windows user that has Administrator permissions.

2. Confirm this operating environment (hardware and software) meets the Sage 300 CRE MyAssistant hardware and software requirements, which are outlined in the Before You Install section of this document.

3. Confirm that you have closed all applications and disabled any User Access Control (UAC), anti-virus or Firewall software that may be running.

4. Confirm that all system software updates/installations have been completed by restarting the server prior to installing MyAssistant. After restarting, log back into the server as a Windows user with Administrator permissions.

5. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is accessible from any workstations where MyAssistant will be installed.

6. Perform the following to initiate the MyAssistant Server Installation:
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to the same location as the .ZIP file (either a local or shared folder).
   c) Open the folder of unzipped MyAssistant installation files and double click autorun.hta

7. The Sage 300 CRE MyAssistant Installation hub will open.

Click [Install Server] to initiate the MyAssistant Server installation.
Step 1 – MyAssistant Server Installation

The MyAssistant Installation Wizard opens after selecting the type of install.

Click [Next] to continue.
Step 2 – MyAssistant License Agreement

You must accept the License Agreement below to use the Sage 300 CRE MyAssistant software. A complete copy of the Innovative Software Design License Agreement is provided with the MyAssistant installation files.

If you agree to the terms of the License Agreement, check the I accept the terms in the license agreement checkbox and click [Next] to continue.
Step 3 – Prerequisites for MyAssistant Server

This window is only displayed if any MyAssistant prerequisites are missing. Green check marks indicate prerequisites that are already installed, while the blue circle indicates those that are missing.

**NOTE:** Only check the “Do not install SQL Server Express” box if you have separately purchased, installed and will be using a full version of the Microsoft SQL Server database. Do not check this box if you are unsure if you have a full version of Microsoft SQL Server installed. By checking this box you are taking full responsibility for the installation, setup, and maintenance of the SQL Server instance used with MyAssistant.

Given the system resource requirements of Microsoft SQL Server Express, installing more than two SQL Server Express instances on the same machine will likely result in performance issues. To prevent this, you can install the MyAssistant Server software on another server, if it meets the hardware and software requirements specified in the “Before You Begin” section of this document.

Click [Next] to begin the install of the necessary prerequisite software.

**IMPORTANT:** The SQL Server install can take up to 20 minutes. Please be patient, and do not cancel the SQL install.
Step 4 – MyAssistant Software

In this step you determine where the MyAssistant program files will be installed on your server.

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to install the MyAssistant software.
Step 5 – You Have Completed Installing the MyAssistant Server

Congratulations, you have completed installing MyAssistant Server software.

Click [Finish] to close the wizard.

**NOTE:** You must complete the Configuration Manager on the server before installing MyAssistant on any Workstations.
Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

Click [Yes]. Continue to Chapter 2 to walk through configuring the MyAssistant Server.

If you do not configure your MyAssistant Server at this time, you can do it later by running the MyAssistant Configuration Manager. This can be opened with the icon installed on your desktop or by going to Start > All Programs > MyAssistant > MyAssistant Configuration Manager.
Chapter 2 – MyAssistant Server Configuration

This chapter walks through configuring the MyAssistant Server software. This process must be done before installing MyAssistant on any Workstations.

Read this section carefully

MyAssistant Server Configuration steps:

1. Activate the software.
2. Select a list of prebuilt Tasks (Construction or Real Estate) to create with your MyAssistant database.
3. Enter the Sage 300 CRE user name and password that MyAssistant will use to access Sage 300 CRE data, and specify the Sage 300 CRE data folders MyAssistant will monitor.
4. Configure server options, including preferences on daily email summaries, error notifications and service settings for running Tasks and sending emails with Notifications.

NOTE: Configuring the MyAssistant Server will take approximately 10 minutes.

Considerations before you begin:

1. If you use Service Management in the Sage 300 Construction and Real Estate software, open the module and run a report. This will verify your connection to the ODBC driver.
2. Confirm that the password associated with the Sage 300 CRE user that MyAssistant will use to access the Sage 300 CRE database does not expire.
3. Any of the configuration settings except the prebuilt Tasks list can be changed after initial setup.
Step 1 – Welcome

If the MyAssistant Configuration Wizard doesn’t start, it can be opened using the desktop icon or by following this path: Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

Check the box next to Show Advanced Options if:
- You are using a Web Proxy Server.
- You are using a full version of the Microsoft SQL Server database.
- You will define the Microsoft SQL Server credentials that will be used to access MyAssistant data.

**CAUTION:** SQL Server credentials should only be changed by someone with in-depth knowledge of SQL Server. Changing the credentials to something other than the default could break the connection to the MyAssistant database.
**Step 2 – Product Activation**

In this step you will activate the MyAssistant Server, as well as enter any Web Proxy Settings.

To activate the software, enter a valid customer number and server product key, both of which were provided with the MyAssistant software. If you do not have this information, please contact Sage Support.

- **Customer number** – Enter your Sage customer number.
- **Product Key** – Enter your Server product key.

**NOTE:** The Web Proxy Server checkbox will only appear if you selected Show Advanced Options in the Welcome step (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and provide the requested information.

After the MyAssistant Server has been activated, click [Next] to continue.
Step 3 – Database Connection

**NOTE:** This step will only be available if you click [Show Advanced Options] in the Welcome step.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port Number MyAssistant is using to connect to the Database.

**CAUTION:** Making changes in this step can break the connection to the MyAssistant database. These fields should only be changed by someone with in-depth knowledge of SQL Server.

Click [Next] to continue.
Step 4 – Create the MyAssistant Database

Select the type of prebuilt MyAssistant Tasks to install. This selection is permanent and cannot be changed for the database being created.

Once a set of prebuilt Tasks is selected, click [Next] to create the database.

**NOTE:** See the “Prebuilt Task List” documents in the MyAssistant install files for a list of the Construction and Real Estate prebuilt Tasks. Use these lists to determine which set of prebuilt Tasks you want to install.
Step 5 – Sage 300 CRE Data Folders

This step is used to specify the Sage 300 CRE data folder(s) that MyAssistant will monitor. Multiple Sage 300 CRE data folders can be entered.

**Sage 300 CRE User** – Enter the Sage 300 CRE user name MyAssistant will use to access the Sage 300 CRE database when Tasks are run.

![MyAssistant Server Configuration Wizard]

**IMPORTANT**: Using a Sage 300 CRE user name with a password that does not expire is highly recommended. Also confirm the Sage 300 CRE user name entered has access and privileges to all Sage records you want to monitor in MyAssistant.

**Sage 300 CRE password** – Enter the password associated with the Sage user entered.

**Specify the Sage 300 CRE Data Folder(s)** – Click in the open field below **Sage 300 Data Folder Location**. Click […] to open a dialog listing all available Sage 300 Data folders and their file paths. Select the data folder you want and click [OK]. Repeat in the next row down to add another data folder, as often as desired. MyAssistant will automatically create an ODBC data connection (Windows DSN) for each Sage 300 CRE data folder specified.
**IMPORTANT:** If the MyAssistant Server is not on the same computer as the Sage 300 CRE Server, try to select a data folder with a local drive or UNC path. If you must use a mapped drive, the MyAssistant Drive Mapper will need to be set up. Please see Chapter 5 for more information on the MyAssistant Drive Mapper.

Click [**Next**] to continue.

**Import Sage Database Customizations**

If you select one data folder, MyAssistant automatically imports the Sage Database Customizations for that folder when you click [**Next**]. If more than one folder is selected, clicking [**Next**] opens a window asking you to specify which data folder’s database customizations to import. Importing database customizations can be run as often as necessary, and accessed any time after the initial installation via the MyAssistant Configuration Manager. Please note only one folder’s Sage database customizations can be in the MyAssistant database at a given time.

The connections to the Sage 300 CRE data folders will be tested when you click [**Next**].

**NOTE:** When you create a custom field in Sage 300 CRE you must import Sage database customizations for MyAssistant to recognize the change. Again, only one Sage data folder’s customizations will be recognized in MyAssistant at a time. Importing another Sage data folder’s customizations will overwrite the previous folder’s customizations in MyAssistant.
Step 6 – Notification E-Mail Account

MyAssistant provides the ability to send emails with Notifications and attachments to specified people when a condition is met. In this step you will specify the email account and Mail Server Settings used to send emails.

**From Name** – Enter the name that email messages containing MyAssistant notifications will come from. This name is displayed in the recipient’s Inbox.

**From E-mail Address** – Enter the email address from which Notification email messages will be sent.

**Outgoing Mail Server** – MyAssistant requires an Outgoing Mail Server to send emails. If using Microsoft Exchange, enter the name of the Exchange server. If Microsoft Exchange is not being used, the email server is determined by your Internet Service Provider (ISP). The outgoing email server used should be associated with the **From E-mail Address** entered. Refer to the instructions on the following pages to determine the name of your outgoing email server.

**Username** – Enter the user name to log on to the specified email account. Refer to the instructions on the following pages to determine the username for the email address entered in the **From E-mail address** field.

**Password** – Enter the password for the specified email account.

Check the box for **This server requires an encrypted SSL connection** if your email server requires a secure connection.
IMPORTANT: You may need to configure SMTP relays to allow the MyAssistant Server to send email messages. Consult the administrator of your mail server to confirm your settings or configure your relays.

Determining Mail Settings in Outlook for Microsoft Office 365 and Outlook 2016

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook for Microsoft Office 365.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the File tab and select Account Settings.
4. In the drop down menu that appears, click [Account Settings].
5. Select the email account that will be used in the Account List, then click [Change].
6. Enter the name displayed in the Mail Server field as your Outgoing Mail Server in MyAssistant.
7. Enter the user name displayed in the User Name field as your user name in MyAssistant.
Determining Mail Settings in Outlook 2013

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook 2013.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the File tab and select Account Settings.
4. In the drop down menu that appears, click [Account Settings].
5. Select the email account that will be used in the Account List, then click [Change].
6. Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your Outgoing Mail Server in MyAssistant.
7. Enter the user name displayed in the User Name field as your user name in MyAssistant.
Determining Mail Settings in Outlook 2010

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook 2010.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the File tab and select Account Settings.
4. In the drop down menu that appears, click [Account Settings].
5. Select the email account that will be used in the Account List and click [Change].
6. Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your Outgoing Mail Server in MyAssistant.
7. Enter the user name displayed in the User Name field as your user name in MyAssistant.

![Change E-mail Account]

**Internet E-mail Settings**
Each of these settings are required to get your e-mail account working.

**User Information**
- Your Name: John.Doe
- E-mail Address: John.Doe@company.com

**Server Information**

<table>
<thead>
<tr>
<th>Account Type:</th>
<th>POP3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming mail server:</td>
<td>pop3.company.com</td>
</tr>
<tr>
<td>Outgoing mail server (SMTP):</td>
<td>smtp.company.com</td>
</tr>
</tbody>
</table>

**Logon Information**

| User Name: | John.Doe@company.com |
| Password: | ********** |

[Check] Remember password

[ ] Require logon using Secure Password Authentication (SPA)

[Test Account Settings …]

[More Settings …]

[Back] [Next >] [Cancel]
Step 7 – Server Options

In the final step, you determine a variety of settings around the MyAssistant Server.

Daily Summaries: MyAssistant Daily Summary email messages are used to send each recipient their Notifications across several Tasks in one email message. See the MyAssistant User Guide for more information. The time entered here should be after all of your Tasks have finished running.

Send Errors To: The email address entered here is who to notify when MyAssistant encounters an error. It is recommended to send error messages to the primary MyAssistant user.

Save MyCommunicator Email Messages: Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to your business. In addition to creating a record of business-related emails, a copy of the mail messages can be saved and linked to your Sage data (e.g. Jobs, vendors, customers, etc). To enable this function, check the box in this section and click [Browse...] to select a folder location.

Running Tasks and Sending Service Settings: MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background processes (i.e. Windows Services) on the server. These processes are now scalable to increase performance, and can auto-correct in the event of a hang.
These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables affect the system resources used when Tasks run and emails are sent, including:

- The available server memory
- Disk drive performance
- Other server demands at the time the MyAssistant Tasks are run or emails are being generated. For example, running Tasks at night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

- Complete the MyAssistant Server Configuration Wizard with the default settings and the MyAssistant Workstation installation.
- Activate two MyAssistant Tasks you will regularly use.
- Monitor the server memory usage and disk queue lengths when the Tasks are run concurrently.
- Open the MyAssistant Configuration Manager and increase or decrease the number or processes based on the results of this test and available server resources.

Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard has closed, the Server portion of the MyAssistant installation is complete. Continue to Chapter 3 to install the MyAssistant Workstation.
Chapter 3 – Installing MyAssistant Workstation

**IMPORTANT:** If you are installing on a Terminal or Citrix Server, please go to Chapter 6.

Before beginning the MyAssistant installation on your workstation, make sure you can open Sage 300 CRE on the machine. If you use Service Management, also open Service Management and run a report to ensure the ODBC connection to the SM database has been established.

Perform the following to install MyAssistant:

1. Log on to the machine that will be the Sage 300 MyAssistant Workstation with a Windows user that has Administrator or unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

3. Confirm that all system software updates/installations have been completed by restarting the machine prior to installing MyAssistant.

4. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. If accessible from the workstation, you can use the same files that were used to install on the MyAssistant Server. Perform the following to initiate the MyAssistant Workstation Installation.
   
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to a folder on the local drive on the machine.
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

5. The Sage 300 CRE MyAssistant Installation hub will open.

**Install Workstation** – Select Install Workstation to begin the MyAssistant Workstation install process.
Step 1 – Welcome

When you select **Workstation Install** in the MyAssistant splash screen, the Setup Workstation wizard will appear.

Click [Next] to continue.
Step 2 – MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

Click [Next] to continue.
**Step 3 – Prerequisites for MyAssistant Workstation**

This window displays the prerequisite software that MyAssistant will install. The green check mark is beside the software already installed on your machine. The blue circle is beside the software MyAssistant will need to install. If all prerequisites are already installed, this step will be skipped.

Click [Next] to continue with the MyAssistant Workstation Install.
Step 4 – Install the Software

In this step you will determine where the MyAssistant program files will be installed on your workstation.

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to install the MyAssistant software on the workstation.
Step 5 – You Have Completed Installing MyAssistant

Congratulations, MyAssistant has successfully been installed on this machine. When launched for the first time MyAssistant will ask you to provide some basic information to activate and connect to the MyAssistant Server.

Click [Finish] to close the setup wizard.
Chapter 4 – MyAssistant Workstation Configuration

**CAUTION:** Each MyAssistant activation is tied to a single Windows user on one computer. Make sure that you are logged in to the correct Windows User Account prior to activating the MyAssistant software. This sometimes is not the same as the Administrator account used to install the MyAssistant Workstation.

After completing the MyAssistant Workstation installation, a MyAssistant shortcut is added to the desktop. Each time MyAssistant is opened by a Windows user that has not previously activated the software, they will be prompted to activate and specify their user-specific settings.

Configuring the MyAssistant Workstation will take approximately 5 minutes.

**Step 1 – Welcome Screen**

If there is not a shortcut on the desktop, open MyAssistant using the following path:

Start Menu > All Programs > MyAssistant > MyAssistant
Step 2 – Product Activation

MyAssistant must be activated to use it. A working internet connection is required to complete this step.

**NOTE:** The Web Proxy Settings will only be visible if you clicked [Show Advanced Options] in the Welcome step and if you check Use Web Proxy Server. If you don’t know if you’re using a Web Proxy Server, it is recommended that you leave the box unchecked.

**Customer Number** – Enter your Sage customer number.

**Product Key** – Enter the Product Key that corresponds with the MyAssistant edition you would like to activate.

**MyAssistant Designer** – MyAssistant Designer is the full version of MyAssistant. The MyAssistant Designer provides the ability to create, activate and change Tasks; as well as run Tasks and view the Notification logs.

**MyAssistant** – MyAssistant has the ability to run tasks on demand and view the Notification log. This version does not provide the option to create, activate or change tasks.

**NOTE:** Your customer number and product keys were provided with the MyAssistant installation files. If you do not have this information, please contact Sage Support.
Step 3 – Entering Sage 300 CRE Data Folder Information

The Sage 300 CRE Database Settings are used to connect to your Sage 300 CRE database from the workstation.

Specify Sage 300 CRE data folder locations – The data folders specified during the MyAssistant server setup will be listed in the grid. MyAssistant will automatically set up an ODBC data connection for each Sage 300 CRE data folder given the specified location/path. Click in the Sage 300 CRE Folder Location column and then the ellipsis “…” button to select the appropriate path for each Sage 300 CRE data folder. (You may not see all of your data folders, which is normal.)

Check the Ignore check box for any Sage 300 CRE data folders that should not be accessed on this workstation.

Sage 300 CRE Operator ID and Password – If security is enabled in Sage 300 CRE, enter your operator ID and password. These credentials will be used to run Sage 300 CRE reports and inquiries, as well as to test conditions.

Clicking Next will test each data folder connection as well as the Sage 300 CRE credentials.
Step 4 – User Profile

Complete the Personal Information step with information for the Windows User on this machine.

**Windows User** – This field is automatically filled with the Windows user name that is currently logged on to the computer.

**Your Name** – Enter the user’s name.

**Email Address** – Enter the user’s email address.

Sage 300 CRE MyAssistant will start when you click [Finish].
Chapter 5 – Additional Settings

Antivirus Exceptions
Sage 300 CRE MyAssistant can send Notification emails when specified situations are identified. However, many common antivirus, Internet filtering or Firewall products can block emails sent via MyAssistant if certain are not added to a specified list of applications from sending email messages.

If you are running antivirus or Internet filtering software, please add MyAssistant.exe, ISDAdminService.exe, ReportRunner.exe, TaskRunner.exe and MyAssistantConfigurationManager.exe to the exceptions list contained in the antivirus or Internet filtering software. This only needs to be done on the MyAssistant Server.

MyAssistant Drive Mapper Tool
If you use one or more Mapped Drives (i.e., drive letter “T:”) to access your Sage 300 CRE data or Program Files, you need to install the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows Service that runs MyAssistant Tasks to access your Sage 300 CRE data or programs.

How do I know if I need to use the MyAssistant Drive Mapper?
The MyAssistant Drive Mapper needs to be used any time a mapped drive is used to access Sage data or Program Files instead of a UNC path. There are several places to review to determine which drives, if any, will need to be mapped using the MyAssistant Drive Mapper.

1. Log onto the Server where the MyAssistant Server software is installed
   a. Open the Windows Registry
   b. Navigate to HKEY_LOCAL_MACHINE\Software\(Wow6432node if on a 64 bit machine)\Timberline\General. If a mapped drive is used in any of the paths, you will need to install the Drive Mapper.

2. Start a Sage 300 application.
   a. Go to File > Open Company. If a mapped drive (ex. T:) is used in the path / location of your Sage data folder(s), the MyAssistant Drive Mapper will need to be installed.
   b. Go to File > Company Settings > File Locations. You will need to install the MyAssistant Drive Mapper if a mapped drive (Ex. T:) is in the listed for any Sage data files.

CAUTION: The MyAssistant Drive Mapper needs to be used any time a mapped drive is used to access Sage data or Program Files. If you are using UNC paths, do not use the Drive Mapper tool.

Perform the following to install the MyAssistant Drive Mapper Tool:

1. Log on to the computer where the MyAssistant Server is installed using a Windows user that has Administrator or Unlimited privileges.

2. Open the folder containing the MyAssistant Installation Files.

3. Using Windows Explorer, copy these two files from the Tools\DriveMapperCommand folder in the MyAssistant installation files:
   - InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll
   - DriveMapperCommand.config

Place the above files in the following three locations. If you accepted the default location when installing the MyAssistant software, these locations will be:

1. C:\Program Files\Innovative Software Design\My Assistant
2. C:\Program Files\Innovative Software Design\MyAssistant\SendService
3. C:\Program Files\Innovative Software Design\MyAssistant\TaskService
4. Start the Windows Notepad application.
5. Click File > [Open], and select the DriveMapperCommand.config file from the folder that this file was copied into. The contents of the file should be the following:

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```

6. Replace the value between the `<DriveLetter>` and `</DriveLetter>` labels with the drive letter you use to access your Sage 300 CRE data.

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```
7. Replace the value between `<UNCPATH>` and `</UNCPATH>` labels with the UNC path that the drive is currently mapped to for this user.

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPATH\MACHINENAME\Timberlinesharesharenamed</UNCPATH>
  </MappedDrive>
</DriveMapperConfig>
```

If you do not know the UNC path that the Sage 300 CRE drive is currently mapped as, open Windows Explorer and click on Tools -> Map Network Drive. In the drive letter list, it will show how each drive is mapped.
8. If you have different Sage 300 CRE Data folders on different mapped drives, you will need to map multiple drives. To do this, add a <MappedDrive> section for each additional drive.

```xml
<DriveMapperConfig>
    <MappedDrive>
        <DriveLetter>U</DriveLetter>
        <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
    </MappedDrive>
    <MappedDrive>
        <DriveLetter>U</DriveLetter>
        <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
    </MappedDrive>
</DriveMapperConfig>
```

Save your changes using the Save option on the File menu and close the Notepad application.
Chapter 6 – Installing on a Terminal Server

**CAUTION:** This chapter is written for clients who will be running the MyAssistant Server and at least one MyAssistant User on a Terminal or Citrix Server.

**What is Involved**
Perform the following to install MyAssistant on a Terminal or Citrix Server:

1. Log onto the Server as a System Administrator
2. Run the MyAssistant Server Installation Wizard
3. Activate and configure the MyAssistant Server
4. Log onto the machine with the Windows credentials of the user who will run the software
5. Open the MyAssistant user Application
6. Activate and configure MyAssistant for the Windows user

**Before Installing**
Before MyAssistant can be activated on any accounts other than the administrator, permissions must be given to specific files. The default paths have been provided below, but they may vary.

- C:\Program Data
- C:\Program Files\Innovative Software Design
- C:\Program Files(x86)\Innovative Software Design

**IMPORTANT:** Permissions need to be given to these folders prior to activating any MyAssistant users on this machine.

**Installing the MyAssistant Server**
Return to Chapters 1 and 2 for installing and configuring the MyAssistant Server. When you have completed Chapter 2, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix Server.

**Activating the MyAssistant Workstation**
Once the MyAssistant Server is installed and activated, log onto the Terminal or Citrix Server as the Windows user who will be using the MyAssistant software.

- If there is a **MyAssistant** icon on the desktop, double click to open the User Configuration Manager.
- If there is not an icon on the desktop, follow this path:
  - Start > All Programs > Sage > MyAssistant (folder) > **MyAssistant**
When the User Configuration Manager is open, refer to Chapter 4 to activate the MyAssistant workstation.

**Conclusion**
This completes the initial setup of the Sage 300 CRE MyAssistant software. The next step is to activate or create MyAssistant Tasks to begin monitoring your business. Please refer to the User Guide for information on using MyAssistant.